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Abstract 
 

In 2007 forty-eight Northwoods red maple (Acer rubrum ‘Northwoods’) were subjected 

to basal stem wounds and three different shredded wood mulch applications (15cm deep 

with no stem contact, 15cm deep with stem contact, 30cm deep with stem contact).  

Trees were grown in a typical landscape setting for three growing seasons (30 months) 

after which they were destructively harvested to determine what effects basal stem 

wounds and different mulch depths had on stem growth, new twig growth, number of 

twig nodes, wound occlusion, and internal discoloration. Wounding did not have a 

significant effect on stem growth, new twig growth, or number of twig nodes. Trees 

with 30cm of mulch with stem contact had significantly greater final stem area and twig 

nodes than all other treatments. Mulch treatment did not have a significant effect on 

wound occlusion, stem discoloration in cross-section, or length of columns of stem 

discoloration observed longitudinally in bi-sections. Significant increases in growth 

parameters with 30cm of mulch may be attributed to enhanced water retention in these 

treatments.
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Introduction 

Mulching landscape trees with organic material is a common practice and is often 

prescribed to reduce tree stress and conserve soil moisture. Mulch rings around trees 

may serve to protect trees from mechanical damage from mowers, string trimmers, and 

other landscape maintenance equipment (Chalker-Scott 2007; Herms et al. 2001; 

Mooter et al. 2004; Smith-Fiola 2000). In spite of the positive effects of applying 

mulch, more may not always be better. Many extension and trade articles warn against 

the dangers of over-applying mulch, especially when it is in direct contact with tree 

stems. In such articles, deep mulching is often associated with tree problems such as 

root and stem suffocation, stem damage from excessive heat, fungal and/or bacterial 

infection, stem girdling roots, and early mortality (Ball 1999; Green and Watson 1989; 

Montague 2007; Smith-Fiola 2000). Others suggest that mulches, piled deeply against 

the stem can cause adventitious root formation which may lead to stem-girdling roots 

(SGRs) (Montague et al. 2007). To avoid these issues, most recommendations suggest 

keeping organic mulches well away from tree stems. Unfortunately, little replicated 

research has explored the effects of mulch depth when placed in direct contact with the 

stems of landscape trees.  

 

Conversely, the effects of deep applications of mulch on tree growth and establishment 

have been researched extensively. Some report higher incidence of disease (Koski and 

Jacobi 2004; Jacobs 2005), bark damage from excessive heat and/or moisture (Smith-

Fiola 2000), reduced water infiltration (Gilman and Grabosky 2004), and even reduced 
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plant growth (Arnold 2005; Greenly and Rakow 1995).  

 

Research examining tree wounding, wound occlusion, and internal discoloration and 

decay comprises one of the most researched areas in arboriculture. There is a 

considerable body of knowledge examining internal discoloration and decay in trees 

(Gilman and Knox 2005; Gilman and Grabosky 2006; Grabosky and Gilman 2007; 

Green et al. 1981; Shigo and Marx 1977). Smith (2006) further defined these concepts 

of compartmentalization of decay in trees with a review of results from replicated 

research. Additional work examined growth, internal discoloration, and decay in red 

maples after being damaged in ice storms (Smith and Shortle 2003; Smith et al. 2001). 

 

Unfortunately, the limitations of quantifying discoloration and decay in trees are still 

apparent. Wound occlusion and internal discoloration and decay have traditionally been 

measured using linear measurements and qualitative analysis (Green et al. 1981; Neely 

1988b). Wound occlusion is typically measured using surface characteristics and linear 

measurements, often to calculate the area of an ellipse (Bai et al. 2005; Hudler and 

Jensen-Tracy 2002). New research is needed to examine any relationships between 

mulching materials and practices and common problems with landscape trees. 

Additional results will add to the existing body of knowledge and broaden the 

understanding of biological response of trees to human activities. 
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Literature Review 

Benefits of Mulching Trees 

Mulching is generally considered beneficial to tree health. It retains soil moisture (Faber 

et al. 2003; Greenly and Rakow 1995), increases plant growth (Cregg and Schutzki 

2009), reduces weed competition (Cregg and Schutzki 2009), and limits access to the 

stem from maintenance equipment and other human activities (Arnold et al. 2005; 

Montague et al. 2007; Greenly and Rakow 1995). 

 

Greenly and Rakow (1995) report that mean soil moisture increased with increasing 

mulch depths, up to 25 cm deep. They also report a statistically non-significant 

reduction in soil oxygen with increasing mulch depths ranging from 19.8% under no 

mulch to 18.9% under 25 cm of mulch. The most significant trend in their work was the 

reduction in seasonal soil temperature fluctuations under different mulch depths with 

seasonal means ranging from 21.4º C under no mulch to 18.5º C under 25 cm of mulch. 

Similarly, soils in organic apple (Malus domestica) orchards mulched with wood chips 

retained more soil moisture than control plots (Hoagland et al. 2008). 

 

Mulch type can affect soil moisture content and retention. Soil moisture was 

significantly greater under wood mulch, than under control plots and those with mineral 

mulches, however, soil moisture under pea gravel mulch did not differ significantly 

from wood mulches presumably, due to its smaller particle size which was able to retain 

more moisture (Iles and Dosmann 1999). This moisture retention may lead to less leaf 

scorch on mulched sugar maples, as observed by Green and Watson (1989).   



 

4 

 

 

Soil temperatures are often affected by mulch. Montague et al. (2007) found that soil 

temperatures underneath mulch fluctuated by season and were not consistent with depth 

treatments depending on the time of year temperatures was measured. In October, soil 

temperatures were warmest under 15cm of mulch. In December and February soil 

temperatures were warmest under 30cm of mulch. Iles and Dosmann (1999) examined 

the effects of mineral mulch and wood mulch on red maple. Control plots without 

mulch and those with mineral mulches had significantly greater soil temperatures than 

those under wood-based mulch (shredded bark, wood chip, pine mulches). Not all 

research supports claims of water retention and temperature fluctuation management 

under mulch. Lloyd et al. (2001) found that mulching rhododendron (Rhododendron 

‘Pioneer Silvery Pink’) and Heritage river birch (Betula nigra ‘Heritage’) did not affect 

soil moisture content or temperature. 

 

In addition to soil moisture retention and temperature fluctuation management, mulch 

has been shown to increase soil organic matter and microbial activity. Lloyd et al. 

(2001) found that mulch sourced from ground wood pallets increased soil organic 

matter and soil microbial activity and microbial populations in mulched plots.  

 

Finally, plant growth is usually enhanced by the use of mulches. This may be due to 

enhanced water retention, as described above, or by reducing or eliminating competition 

from weeds and other plants growing under trees and shrubs. Ferrini et al. (2008) 
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observed increases in overall plant growth (trunk diameter, height, and current-year 

twig growth) by using mulches around Tilia × europaea and Aesculus × carnea, 

showing that non-woody organic compost used as mulch produced larger trunk 

diameters than woody mulch (pine bark). Greenly and Rakow (1995) found that mean 

caliper in Pinus strobus and Quercus palustris generally increased with increasing 

mulch depths but was not statistically significant. Shoot growth, however, was 

significantly affected by mulch depth with 7.5 cm offering significantly greater shoot 

growth than 0, 15, or 25 cm mulch depths. Various mulch products (leaves, pine 

nuggets, pine straw, grass clippings, and chipped limbs), caused a 60 to 70% increase in 

stem growth measured as total cross-sectional stem area (TCSA) of young pecan trees 

(Foshee et al. 1996) when compared to trees with sod growing up to the stem and those 

growing surrounded by bare ground. Cregg and Schutzki (2009) also found that weeded 

plots around trees also improved growth when compared to control plots that had 

groundcover growing up to the stem. Green and Watson (1989) found that a 

combination of 5cm of wood chip mulch and 5cm of compost applied to sugar maples 

(Acer saccharum) resulted in significantly greater stem diameters than other treatments 

including unmulched controls. Stems on mulched trees were almost three times larger 

and crowns were twice as big as trees growing without mulch. In woody shrubs, leaf 

gas exchange and overall growth was improved by using wood mulches, presumably 

because of enhanced water retention and swings in soil temperatures (Montague et al. 

2007). 
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Not all mulches are created equal. Iles and Dosmann (1999) found that mineral mulches 

produced trees with greater stem caliper and greater leaf dry mass than wood-based 

mulches. These differences were attributed to increased soil temperatures under wood 

mulch during key growth periods early in the growing season. Soil temperatures under 

wood mulch during the same period may have been low enough to limit growth. TCSA 

increased with increasing mulch depth but did not differ significantly between depths. 

Leaves and pine nuggets had highest TCSA followed by pine straw, grass clippings, 

chipped limbs, bare earth, and sod (Foshee et al. 1996). Roots can also benefit from 

mulching, for instance. Increase in fine root development in the top 5cm of soil under 

mulch has been shown in sugar maple (Green and Watson 1989).  

 

Negative Effects of Mulching 

Despite the benefits of using mulch, research has also demonstrated the negative effects 

of certain types or depths of mulch on tree growth. Most of this work indicates a 

particular mulch depth, mulch particle size, and/or mulch texture where negative 

impacts are most likely to occur.  

 

Gilman and Grabosky (2004) found that recently planted, balled-and-burlapped (B&B) 

live oak (Quercus virginiana) had significantly more water stress (measured as xylem 

water potential) under 15cm of finely textured mulch (shredded) than those growing 

under coarser mulch types (wood chips) and shallower depths (7.5 cm). The authors 

suspect that light watering and rainfall shortly after planting were not sufficient to 
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penetrate 15cm of shredded mulch to sufficiently water the tree. Trees with 15cm of 

shredded mulch were under significantly greater water stress than those without mulch 

over the root ball. After seven and eight months, however, trees with turf groundcover 

and no mulch over the root ball had significantly greater water stress than those with 

any kind or depth of mulch as well as those growing under bare soil. The authors 

attribute this to extensive root establishment of the trees, allowing them to access 

available soil water more effectively while those growing under turf grass faced more 

competition and grew fewer fine roots. Arnold et al. (2005) also report that deep 

mulches can inhibit the penetration of rainfall. They found that soil was nearly twice as 

dry with 22.6 cm of mulch when compared to bare soil. Conversely, light applications 

of mulch (~8 cm) increased soil moisture almost two-fold. 

 

Growth of avocado and citrus in an orchard setting was not significantly improved by 

the use of mulch (Faber et al. 2003). Arnold et al. (2005) found increased mortality and 

reduced stem diameter in Koelreuteria bipinnata when mulched with 22.9 cm of mulch. 

In that same study, Fraxinus pennsylvanica showed similar reductions on stem diameter 

but tree survival was not affected by deep mulching.  

  

The role that mulch plays in soil fertility and soil pH lacks consensus in most research 

reports (Chalker-Scott 2007). Hoagland et al. (2008) found that apple trees growing in 

orchards had lower leaf nitrogen levels when mulched with non-composted wood chips. 

In treatments where compost was added to the non-composted wood chips leaf nitrogen 
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levels increased. Low leaf nitrogen is presumed to be due to nitrogen immobilization 

resulting from the use of non-composted wood chips. Lloyd et al. (2001) found that 

ground pallet wood mulch had more nitrogen immobilized by microbes than non-woody 

mulch treatments. Conversely, Cregg and Shutzki (2009) found that foliar nitrogen 

content in several different woody shrubs was not affected by mulches. Mulch effects 

on soil pH were reported by Iles and Dosmann (1999) where they observed an increase 

in soil pH under pine mulch and hardwood mulch. Other research has shown that soil 

pH was not affected by mulches (Cregg and Shutzki 2009). Greenly and Rakow (1995) 

observed no effect on soil pH under 0, 7.5, 15 or 30cm of shredded hardwood mulch or 

chipped pine bark.  

 

Mulch is sometimes indicated as the source for the culture and transmission of tree 

pathogens. Jacobs (2005) found that steam pasteurization or composting of wood mulch 

from trees infected with Sphaeropsis tip blight, Botryosphaeria canker, and/or 

Armillaria root rot improved growth in Austrian pine (Pinus nigra), eastern redbud 

(Cercis canadensis), and red oak (Quercus rubra) when compared to non-heated or 

non-composted fresh mulch controls. Interestingly, only Sphaeropsis was shown to be 

transmitted via fresh mulch. Koski and Jacobi (2004) examined longevity and 

transmission of Thyonectria austroamericana canker in infected wood chips to mulched 

honeylocust (Gleditsia triacanthos) trees. They found that non-composted, diseased 

woodchips remained a source of fungal inoculum for T. austroamericana infection for 

nearly three years after application. They suggest avoiding non-composted wood mulch 
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for especially susceptible trees like honeylocust. 

 

Wounding, Compartmentalization, Discoloration, and Decay 

Trees growing in planted landscapes are growing in conditions and locations where they 

are exposed to a high threat of injury from human activities. In fact, wounding in 

landscape trees has become so common that it is often considered an unfortunate, but 

recurring component of modern tree production and care (Partyka 1982). In many cases 

it is landscape maintenance itself that causes injuries. Mowers that damage tree stems 

and injure or remove bark may create a point of infection for canker diseases and decay 

(Tisserat 2004). Research over the last 35 to 40 years has shaped a modern 

understanding of tree wounding response and the cascade of internal events that follow. 

Since the publication of Compartmentalization of Decay in Trees by Shigo and Marx 

(1977), dozens of research projects have examined, challenged, supported, and refuted 

what happens inside a tree after wounding. 

  

Shigo (1984), Shigo and Marx (1977), Shortle (1979), and Smith (2006) have published 

key articles where concepts of tree wounding, compartmentalization, discoloration, and 

decay are examined, defined, and discussed. These researchers have researched and 

reviewed how trees use compartmentalization as a response to injury and use existing 

and induced physical and chemical barriers and responses to reduce the internal effects 

of wounding. This work defines the actions required of trees to avoid outright death 

from even small wounds.  
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Wounding 

Tree bark (cork cambium or phellogen) prevents damage and desiccation to vascular 

cambium. Vascular cambium is secondary meristem which gives rise to new phloem 

and xylem tissues during a period of mitosis that occurs for 10 to 12 weeks in temperate 

climates, especially during times of rapid radial expansion (Smith 2008). Damage to 

bark and vascular cambium, whether due to human activities or natural occurrences, 

will affect nearly every tree at some point in its life. Generally, the longer internal 

tissues are exposed to the outside environment their susceptibility to decay organisms 

increases (McDougall and Blanchette 1996). Wounding, and the resulting potential for 

discoloration and decay, reduces the amount of living tissue trees have available for 

storage, support, and growth. 

 

Because open stem wounds are a major point of invasion and colonization by decay 

fungi and other organisms (McDougall and Blanchette 1996; O'Hara 2007), wound 

occlusion would seem critical to ensure future production of clear sapwood that is 

unaffected by discoloration and/or decay. In general, small wounds, especially those 

that disturb little bark, are more likely to close more quickly than large ones. Similarly, 

trees with faster rates of radial growth at the wound will close more quickly (Leben 

1989; Neely 1988a, 1988b, 1979). Wound occlusion is also affected by environmental 

conditions and trees that are water-stressed or unhealthy due to poor site conditions may 

respond poorly or unpredictably to wounding (Biggs and Miles 1988; Hudler 1984; 
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Neely 1979). 

 

Timing of tree wounding is also very important. Biggs and Miles (1988), Leben (1989), 

and Neely (1979) discuss the effect of time of wounding on the rate of wound 

occlusion. They state that wounding early in the growing season, especially during a 

time of active stem growth, will result in more rapid wound occlusion when compared 

to wounds made later or during dormancy or a period of little stem radial growth. In 

spite of extensive research into the area of wounding, trees of the same species often 

react very differently to stem wounding and may not occlude in a predictable manner 

(Shigo and Campana 1977).  

 

Compartmentalization, Discoloration, and Decay 

Compartmentalization is a physical and chemical process in woody plants that is 

initiated by wounding. If successful, the process of compartmentalization can slow, and 

possibly prevent, the spread of discoloration and potential for decay following 

wounding by limiting the pathogenic exposure to wood present only at the time of 

injury, thus protecting wood formed later (Hudler 1984; Pearce 2000; Shigo 1984; 

Shigo and Marx 1977; Shortle et al. 1995; Smith 2006). 

 

In deciduous trees, the first step of compartmentalization begins immediately after 

injury. To protect exposed sapwood, metabolic changes begin producing lipids, waxes, 

and/or suberins. These compounds seal exposed areas to prevent extensive desiccation 
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and cell death. Xylem parenchyma cells at and near the point of injury desiccate and 

stop functioning, thus limiting transport of pathogenic microorganisms to other parts of 

the tree. Other conductive tissues are plugged with secondary compounds such as gums 

and resins or are occluded through physiological changes like ballooning of cell walls 

observed in tyloses (Hudler 1984; Pearce 2000; Shigo 1984; Sinclair et al. 1987; Smith 

2006).  

 

The next step consists of the formation of a barrier zone in the vascular cambium to 

protect new wood formed after the injury occurs. The purpose of this barrier is to 

compartmentalize, or enclose, potentially damaging microbial agents and activity to 

prevent it from damaging other parts of the plant. If successful, this process limits 

discoloration and decay to only the wood present at the time of injury (Smith 2006; 

Shigo 1984; Shortle et al. 1995; Sinclair et al. 1987). Within a few days, antifungal 

compounds are produced to limit establishment and slow the spread of decay fungi 

(Pearce 2000). Suberization of tissue after wounding also prevents invasion of 

pathogens. Suberized phellem, located just inside of dead bark tissue, is a product of 

this process (Biggs and Miles 1988; Hudler 1984; Vasiliauskas and Stenlid (1998)). 

 

The final steps of compartmentalization create a continuous barrier of protection. 

Previously dried xylem re-wets and accumulates potassium cations allowing water and 

metabolites to accumulate at the edge of the boundary zone. This process begins a 

period of impregnation where dead cells and tissues fill with insoluble polymers. These 
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polymers act as long-lived free radicals which stop the enzymatic activity of fungi that 

break down lignin and cellulose (Pearce 2000). Compartmentalization may not be 

limited to just the area of wounding. If necessary, xylem not directly affected by 

wounding may cease to function (Hudler 1984) and boundary zones created by the 

compartmentalization process may move away from the site of original wounding to 

contain infection by microorganisms. 

 

The process of compartmentalization, in many cases, results in the affected 

(compartmentalized) tissue to become discolored. In red maple, phenolic concentrations 

can be as much as four times greater in these discolored peripheral areas than in clear 

sapwood. Additionally, these phenol-rich and brightly-colored reaction zones and 

discolored wood have been shown to inhibit the growth of Polyporus versicolor, and 

other common pioneer decay fungi in red maple (Smith 2008; Shortle 1979).   

 

The ability of trees to resist extensive internal damage from wounding is based on a 

number of factors. Tree species is often cited to be one of the largest and most 

predictable variables affecting discoloration and compartmentalization. Some species 

are more effective than others due to inherent functional traits and physiology (Smith 

2006; Dujesiefken et al. 2005; Dujesiefken et al. 1999; Martin and Sydnor 1987; Shortle 

and Cowling 1978). Some research, however, reports variable and unpredictable wound 

responses even within species. Santamour (1986) examined the effects of stem wounds 

and internal discoloration response of several cultivated tree varieties. In spite of a tree's 
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ability to compartmentalize, aggressive decay fungi may invade tissue before protection 

zones are completed. Repeated wounding at the same location, especially when it 

disturbs protective walls formed by compartmentalization, results in more extensive 

vertical columns of discoloration. Because these responses require the use of stored 

energy, trees that have poor reserves due to environmental stress and other factors may 

be less able to effectively form boundary zones for protection (Smith 2006).  

 

Unfortunately, sapwood formed after wounding is not completely immune to fungal 

attack from compartmentalized pathogens (Shigo 1983; Shigo and Marx 1977; Smith 

2006). If compartmentalization fails to contain the initial damage caused by wounding, 

new tissue becomes susceptible to attack and is transformed as a result of the 

compartmentalization process. Many pathogenic fungi are well-suited to escape 

compartmentalization and attack new sapwood, resulting in wounds increasing in size 

over time and may initiate the formation of perennial cankers (Sinclair et al. 1987). 

 

Additionally, the effects of continuous or repeated injury deplete resources made 

unavailable due to compartmentalization and subsequent use of stored reserves to 

respond to wounding to create boundary zones. This stress reduces a tree’s ability to 

effectively compartmentalize (Shigo 1983). The continued ability to avoid decay at 

these lines of defense is often a function of the protective chemical compounds present 

or created at the time of wounding. Repeated attacks at the barrier zone may result in 

reduction or depletion of the compounds and may eventually lead to decay (Eisner et al. 
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2002).  

 

As described above, a tree produces changes in chemistry to protect tissue which can 

cause staining of tissue (Rier and Shigo 1972; Smith and Shortle 1998). The presence of 

discoloration doesn’t necessarily indicate the presence of pathogenic fungi. Dujesiefken 

et al. (2005) refer to discoloration as simply a response to injury and a natural 

component of decay resistance – specifically, resistance to the spread of decay. While a 

wound starts the discoloration process it may or may not lead to decay (Rier and Shigo 

1972), the discolored tissue is, in fact, darker than normal sapwood because it is 

undergoing a process that will limit its susceptibility to decay by fungi and other 

microorganisms (Pearce 2000; Neely 1988a; Shortle et al. 1995; Sinclair et al 1987). 

 

Some factors cause an increase in internal discoloration. Shortle et al. (1995) found that 

fungal inoculation after wounding increased the amount of discoloration in red maple. 

Repeated injuries also have a negative effect on tree defenses. Even more apparent are 

the effects of repeated injuries on the extent of internal discoloration. Smith et al. (2001) 

found that, in storm-damaged trees, internal discoloration and decay was greatest in 

trees that were previously wounded. This increase was most notable when trees were 

injured on the lower trunk. Repeated wounding can cause more extensive internal 

discoloration and vertical columns of discoloration are often more likely to merge 

together (Shigo 1983; Shigo and Campana 1977).  
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Responses to wounding and discoloration of wood are very different from the formation 

of heartwood. Heartwood formation is a natural process in which some species of trees 

form discolored wood in interior portions of aging tree stems and functions as storage 

and support (Shigo and Hillis 1973). Although, no longer living, the presence of 

compounds in heartwood allow for chemical responses to wounding, fungal infection, 

or other events (Shigo 1993; Shigo and Hillis 1973). Dead parenchyma cells in darkly 

stained heartwood are characterized by high concentrations of phenols and terpenes that 

inhibit decay (Sinclair et al. 1987; Smith 2008). 

 

Wound Treatments 

Open wounds are generally perceived to be more susceptible to attack by decay 

organisms than fully occluded wounds. Therefore, it is no surprise that a large volume 

of research has focused on treatments that cover or seal wounds on trees. Wound 

wrapping or covering treatments and various types of brush or spray-on wound 

treatments have been researched to determine if this prevents organisms from 

colonizing exposed woody tissue.  

 

Limiting or eliminating the oxygen source to fungal invaders may play a role in 

reducing the potential for internal discoloration and decay. In a study examining the 

effects of introduced chemicals in drilled holes in red maples, Houston (1971) found 

that white glue (Elmer's Glue-All, Borden Co.) was more effective in reducing both the 

length of internal discoloration columns than common anti-fungal and anti-microbial 
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chemicals. Vasiliauskas and Stenlid (1998) offer slightly contradictory evidence by 

showing that rate of internal discoloration in wounded Fraxinus excelsior was not 

affected by wound occlusion. They suggest that columns of discoloration were formed 

long before wounds were occluded and the two were unrelated, supporting other 

research that relates wound closure to radial growth rate at the wound site (Leben 1989; 

Neely 1979). Additionally, Dessureault and Rich (1974) also found that applications of 

lanolin alone and in combination with auxin, gibberellic acid, and zinc oxide increased 

callus formation and reduced columns of discoloration by 50% three months after 

wounding. This supports the hypothesis that internal discoloration can be affected by 

available oxygen; however, timing of observation is important because research that has 

examined discoloration in relation to wound treatments after disparate time periods 

seems to offer contradictory results. 

 

Moisture loss at the time of wounding also plays a role in tree defense. McDougall and 

Blanchette (1996) examined the effects of covering tree wounds with plastic wrap 

(PEP). Their work on Acer rubrum found that PEP wraps significantly reduced wound 

occlusion time when compared to non-wrapped controls. Calabro (1998), Dujesiefken et 

al. (1999), and Shortle and Shigo (1978) report that prompt wrapping of wounds can 

significantly increase the rate of wound occlusion over time in some species.  

 

Calabro (1998) and Dujesiefken et al. (1999) also noted less discoloration in wounds 

wrapped with plastic. In contrast, Hudler and Jensen Tracy (2002) found that an 
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application of Lac Balsam®, a product commonly prescribed for covering tree wounds, 

decreased the rate of wound occlusion and increased the amount of internal 

discoloration. Their conclusions, however, report that these findings didn’t affect tree 

growth or function and could safely be used for aesthetic purposes. 

 

Problem Statement 

The biological effects of common landscape practices and stem injury to trees are still 

relatively misunderstood or misinterpreted. Some current recommendations are based 

on unsubstantiated advice and not replicated research. Specific questions remain in how 

tree growth is affected by deep mulching in contact with tree stems and basal stem 

wounds. Additionally, there is some contradiction in how these practices and events 

affect internal stem function and integrity of landscape trees. 

 

The limitations of quantifying discoloration in trees are still very apparent. Wound 

occlusion and internal discoloration has been measured using linear measurements and 

qualitative analysis. Only recently have researchers used techniques other than basic 

linear measurements and qualitative analysis to quantify the extent of internal defects in 

trees (Gilman and Grabosky 2006; Gilman and Knox 2005; Grabosky and Gilman 

2007).  

 

Using digital photography and modern image analysis techniques, this research 

proposed to quantify, with a high degree of accuracy and confidence, how mulch depth 
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and placement against stems combined with stem wounds affect tree growth parameters. 

The rate of wound occlusion and the extent of internal discoloration as affected by 

mulch placement against stems were also measured and analyzed. These measurements 

will be compared to external, linear measurements to further quantify the benefits of 

using such techniques in research into these areas. Development of protocols for these 

analyses will be useful for future studies in similar areas of research.  

 

Materials and Methods 

Experimental Design 

In November of 2006, 50 Acer rubrum ‘Northwoods’ trees were planted in a Waukegan 

clay-loam at the University of Minnesota’s Urban Forestry & Horticulture Research 

Nursery in St. Paul, MN. All trees were containerized nursery stock grown in Grip Lip 

GL4000 containers (#10 trade size: top diameter 36.2 cm, height 36.2 cm, bottom 

diameter 33 cm, volume 34 L), donated by a local wholesale nursery. Initial stem 

diameter was measured as stem caliper at 11cm above the soil line in two directions and 

ranged from 40.2 mm to 42.5 mm and did not differ significantly among the treatments.   

 

Prior to planting, root systems were inspected and cleaned to remove all excess 

container substrate, exposing what is commonly called the first main-order root. After 

planting depth adjustment, trees were placed into machine-augured, 90 cm wide holes in 

a chewings fescue (Festuca rubra commutata) turf lawn. Depth of the holes was 

variable, requiring adjustment of the subsoil to keep the first main-order root at, or near, 
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the soil surface. After watering, trees were left un-mulched over the first winter of 

2006-2007.   

 

On 22 June 2007, 48 trees were randomly assigned one of the following six treatment 

combinations replicated eight times: 

 

1. 15cm mulch, no stem contact, no stem wound   

2. 15cm mulch, no stem contact, stem wound   

3. 15cm mulch, stem contact, no stem wound   

4. 15cm mulch, stem contact, stem wound   

5. 30cm mulch, stem contact, no stem wound   

6. 30cm mulch, stem contact, stem wound   

 

Stem wounds were made at the base of each wounded tree in a size and at a location 

consistent with common mechanical injury by commercial lawn mowers. A section of 

bark was marked at 15cm off the ground on the southeast side (randomly selected) with 

a straight-bladed grafting knife removing a 25.4 mm (horizontal) x 50.9 mm (vertical) 

section of bark and active vascular cambium. Care was taken to avoid cutting deeply 

into stem tissue. The 15cm deep mulch treatment with stem contact reached the base of 

the wound on the wounded trees. The 30cm mulch treatment completely covered stem 

wounds. 
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Mulch treatments were applied immediately after wounding. Mulch was medium to 

coarsely textured and was predominantly from deciduous hardwood sources. Mulch was 

shredded during the season of application and was non-composted. Control treatments 

consisted of a 0.9 m x 0.9 m square mulch application at 15cm deep surrounding the 

tree in a mound without direct contact with the stem. After application, mulch was 

pulled back 2 to 3cm from the stem to avoid direct contact. The 15 and 30cm deep 

mulch treatments were applied using the same method except that mulch was placed in 

direct contact with the stem.  

 

Additional wood mulch was applied in November of 2007 and 2008 to ensure that 

prescribed mulch depths were maintained, because mulch depth had decreased due to 

decomposition (Foshee et al. 1996). To measure the rate and extent of wound occlusion, 

digital photos (Olympus Digital SLR E-510, Olympus America Corporation, Center 

Valley, PA) of each wound were collected on 26 June 2008, 08 August 2008, 19 

November 2008, 08 May 2009, 26 October 2009, and 29 January 2010. All trees were 

irrigated with overhead irrigation as needed during 2007. No supplemental irrigation 

was applied during 2008 and 2009. 

 

Harvest and Stem Sectioning 

In November 2009 mulch height was recorded on the stem of all trees to note rate of 

mulch decomposition over one year. Next, all mulch was removed to allow access for 

harvest. To determine treatment effects on current-year (2009) twig growth, total new 
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growth was measured and numbers of nodes were counted on eight, randomly selected 

branches. Two branches were collected in each of the four cardinal directions on each 

tree. In January 2010, all above-ground tissue was removed at the soil line using a hand 

saw. Harvested tissue was stored frozen at -18° C in sealed polyethylene bags on metal 

racks until ready for processing. Final photos of external wound occlusion were also 

taken at this time. All branches were removed using a hand shears and tree stems were 

cut at approximately 1.5 m above the soil line to facilitate long-term freezer storage. 

 

All samples were cut on a band saw (JET Band Saw JWBS-140S, JET Tools North 

America, La Vergne, TN) using a 203cm blade with 1.6 teeth per cm (Craftsman Band 

Saw Blade, Sears Holdings Corporation, Hoffman Estates, IL). Three cuts were made 

on each tree after harvest (Appendix A). The first cut was made in cross-section at a 

point 6.5 cm below the center of wound for wounded trees or 11 cm above soil surface 

for non-wounded trees. This cut surface was used to measure stem growth in a 

consistent area of the stem unaffected by wounding. The second cut was made in cross 

section through the center of each wound and was used to measure the area of 

discolored stem in cross-section (Grabosky and Gilman 2007; Smith and Shortle 1993). 

Non-wounded trees were cut in the same location. The third cut was made up from the 

center of the wound to bisect the stem longitudinally upward. This section was used to 

measure the length of the column of discoloration upward from the center of the wound 

(Grabosky and Gilman 2007; Hudler and Jensen-Tracy 2002). All cut surfaces were 

sanded with a disc sander (Craftsman Disc Sander, Sears Holdings Corporation, 
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Hoffman Estates, IL) using 60 grit sandpaper discs (Craftsman Sandpaper Discs, Model 

No. 28314, Sears Holdings Corporation, Hoffman Estates, IL) and a belt sander (Ryobi 

BD4600 Belt Sander, Ryobi Group, Shelbyville, IN) with 120 grit (3M Brand Sanding 

Belts, P120, 241DL, 3M Company, St. Paul, MN) and 400 grit (Buffalo Brand Sanding 

Belts,  A400, X871K, Buffalo Abrasives, Inc., North Tonawanda, NY) sanding belts. 

Sections were hand sanded to a shiny surface using 600 grit wet/dry sandpaper and a 

sanding block (3M Wetordry Sandpaper, 413Q, 3M Company, St. Paul, MN). All 

sections were stored frozen in sealed plastic bags at -18° C until ready for digital 

photography. 

 

Variable Measurement and Image Analysis 

Digital photos of cut sections were taken using an Olympus E-510 digital SLR camera 

(Olympus America Corporation, Center Valley, PA) equipped with a standard and 50 

mm and macro lens controlled by a computer running Olympus Studio 2.0. (Olympus 

America Corporation, Center Valley, PA). Samples were staged in an Alzo Digital 

Macro Studio (Akces Media LLC, Bethel, CT) and illuminated using cool-white 

fluorescent lamps in a photo tent. 

 

To quantify the effects of wounding and mulch treatments on annual stem growth rate, 

initial stem diameter, final stem diameter, and total final TCSA of each tree was 

measured using ImageJ at 11cm above the soil surface. TCSA was also measured at 

17.5cm above the soil surface, at the point that cuts horizontally through the center of 
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the wound in wounded trees (Schneider et al 2012; Soille and Mission, 2001) 

(Appendix B & E). Staining was not necessary to see ring boundaries in these samples. 

Cells formed later in the season are darker with thicker walls and provided distinct 

boundaries for delineation of annual growth rings (Smith and Shortle 2003).  

 

Wound occlusion was measured using digital photo planimetry and ImageJ software 

(Appendix B & F). ImageJ is commonly used in medical research to measure the rate of 

wound occlusion by tracing the wound edge using the mouse or other pointing device 

(Keylock et al 2008; Oudhoff 2009; Schneider et al. 2012). Using a scale included in 

each photo, the non-occluded portion of each wound was traced and excluded from the 

area that was originally wounded (25.4mm x 50.8mm).  

 

The area of an ellipse (area = (height * width) / 4 * π) was also calculated using final 

wound dimensions measured vertically and horizontally to compare results with actual 

area measured as described above (Hudler and Jensen-Tracy 2002) .  

 

Repeated measures analysis of variance followed by Tukey’s HSD post-hoc (P < 0.05) 

functions in the GLM function of SPSS Statistics 19.0. (SPSS, Inc., 2012) was used to 

examine the rate of wound closure over time. In cases in which the assumption of 

sphericity was violated, the Greenhouse-Geisser correction was used to adjust degrees 

of freedom and calculate a valid F-statistic for repeated measures analysis. 
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ImageJ (Schneider et al. 2012) was used to calculate the length of the column of 

discoloration longitudinally in stem bi-sections (Appendix B & C) and the area of 

discoloration in cross-sections (Appendix B & D). This method automatically 

accomplishes similar methods of hand tracing and measurement using an area light 

meter (Delta T model RS 232C, Delta T Devices Inc., Cambridge, U.K.) as described 

by Gilman and Grabosky (2007). 

 

Area of discolored cross-sections and length of discolored columns data was normalized 

before statistical analysis. Normalization procedure involved dividing discolored stem 

area by TCSA at the same point and dividing the length of discolored columns by total 

length of the column. The resulting ratios were transformed using a log10 for cross-

sections and an arcsine-square root formula for bi-sections; transformed data was then 

subjected to statistical analysis. Wound occlusion data was transformed using an 

arcsine-square root formula to account for zeros obtained for completely occluded 

wounds. All data was back-transformed for reporting (Gilman and Grabosky 2004; 

Eisner et al. 2002; Smith and Shortle 1993). 

 

The effects of mulching treatment, wounding, and their interaction on final TCSA, 

initial stem diameter, twig growth, number of nodes, and final wound dimensions were 

determined with analysis of variance based on the general linear model function in 

SPSS Statistics 19.0 (SPSS, Inc., 2012). Post-hoc analysis and mean separations 

between treatments was performed using Tukey’s HSD (P < 0.05) functions of SPSS 
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19.0.  

 

Results 

 

Tree Mortality 

One wounded tree with 15cm deep mulch without stem contact died during first the 

winter after stem wounding and mulch applications (2007-2008). Cause of death was 

apparently winter, cold temperature mortality and did not appear to be related to 

wounding or mulching treatments.  The Tukey HSD post-hoc test used throughout this 

study includes the Tukey-Kramer modification in statistical analysis to compensate for 

unequal sample size and to calculate confidence intervals for mean differences, and 

mean separations. 

 

Stem Growth 

There was no significant effect of wounding on final TCSA measured at either 11cm or 

17.5cm at P < 0.05 significance level [F(1, 40) = 0.001, P = 0.981] and [F(1, 38) = 

1.405, P = 0.243], respectively. The main effect of mulch treatment had a significant 

effect on TCSA growth when measured at 11cm [F(2, 40) = 5.014, P = 0.011] but not at 

17.5cm [F(2, 38) = 0.500, P = 0.611]. The interaction of wounding and mulch treatment 

and their effects on TCSA growth was significant at 11cm [F (2, 40) = 5.178, P = 

0.010] but non-significant when TCSA was measured at 17.5cm [F (2, 38) = 1.308, P = 

0.282]. Mean separations using Tukey’s HSD post hoc test showed that trees with 30cm 

of mulch with stem contact had significantly greater final TCSA when measured at 
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11cm but not at 17.5cm. In non-wounded trees, TCSA growth measured at 11cm 

increased as mulch depth against the stems increased (Table 1).  

 

Twig Growth 

Two branches from wounded trees with 15cm and 30cm of mulch with stem contact 

were broken before measurement and were not measurable, reducing n from 64 to 63 in 

both cases. 

 

There was no significant effect of wounding on length of twig growth at the P < 0.05 

significance level [F(1, 368) = 0.338, P = 0.561]. Similarly the effect of mulch 

treatment was not significant at P < 0.05 significance level [F(2, 368) = 1.244, P = 

0.289. In general, new twig growth produced in 2009 (Table 2) was greatest under 

30cm of mulch with stem contact in non-wounded trees and under 15cm of mulch with 

stem contact in wounded trees (Table 2).  

 

Similar to results observed in twig length, wounding did not have a significant effect on 

the number of nodes produced in 2009 [F(1, 368) = 0.613, P = 0.434]. Mulch treatment, 

however, had a highly significant effect on the number of nodes produced [F(2, 368) = 

8.014, P < 0.001]. The interaction of wounding and mulch also had a significant effect 

on node production [F(2, 368) = 3.324, P = 0.037] (Table 2). Mean separations using 

Tukey’s HSD post hoc test showed that trees responded to mulch treatment by 

producing more nodes under 30cm of mulch with stem contact than under 15cm of 
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mulch with and without stem contact. 

 

Wound Occlusion 

When the experiment was terminated, thirteen trees had fully-occluded stem wounds: 

four at 15cm without stem contact of mulch, five at 15cm of mulch with stem contact, 

and four at 30cm of mulch with stem contact. The number of trees exhibiting fully 

closed wounds did not differ significantly between any mulch treatments. Analysis of 

variance examining the effects of mulch treatment on the ratio of final open wound area 

showed that mulch treatment did not have a significant effect on the extent of wound 

occlusion [F(2, 20) = 0.127, P = 0.881] In general, final open wound area was greatest 

under 30cm with stem contact, followed by 15cm with stem contact, and 15cm without 

stem contact. The final height of wound opening was greatest under 15cm followed by 

15cm without stem contact. The final width of wound opening was greatest under 30cm 

followed by 15cm without stem contact, and 15cm with stem contact (Table 3). 

 

An analysis of variance with repeated measures using a Greenhouse-Geisser correction 

determined that mean non-occluded wound area differed significantly between time 

points [F(2.088, 37.578) = 254.886, P < 0.001]. Post hoc tests using the Bonferroni 

correction, however, showed that mulch depth did not interact significantly with the 

time factor [F(4.175, 37.578) = 1.764, P = 0.154].  

 

The relationship between stem growth (final stem diameter at 11cm, final TCSA at 
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11cm, and final TCSA at 17.5cm) and the extent of wound closure (final open wound 

area at experiment termination) was examined using Pearson correlation coefficient. 

There was a significant negative correlation between final open wound area and TCSA 

measured at 17.5cm only, r = -0.745, n = 23, P = 0.000.  Final TCSA and final stem 

diameter measured at 11cm showed a weak, non-significant, positive correlation, r = 

0.353, n = 23, P = 0.099 and r = 0.378, n = 23, P = 0.075, respectively. 

 

Stem Discoloration 

Three replicates were removed from bi-section column of discoloration analysis. The 

first was a wounded replicate with a 15cm mulch treatment with stem contact which 

was removed due to a sanding error which removed the central portion of the bisected 

stem necessary for analysis. Two additional wounded replicates, both with a 30cm 

mulch treatment, suffered secondary staining during storage at temperatures above 

freezing and were not measurable. 

 

Mean percent of stem discoloration in cross-section was greatest in trees with 15cm of 

mulch without stem contact, followed by trees with 15cm of mulch with stem contact, 

and least in trees with 30cm of mulch with stem contact (Table 4). Analysis of variance 

showed that mulch treatment did not have a significant effect on area of discoloration 

measured in cross-section [F(2, 20) = 0.689, P = 0.514]. 

 

The column of discoloration arising from wounding was generally longest in trees with 



 

30 

 

30cm of mulch with stem contact, followed by trees with 15cm of mulch without stem 

contact, and least with 15cm of mulch with stem contact. There were no significant 

differences in length of column of discoloration between mulch depth [F(2, 17) = 1.703, 

P = 0.212] (Table 4).  

 

Discussion 

Stem and Twig Growth Rate  

In this study, final TCSA measured at 11cm was significantly increased under 30cm 

mulch with stem contact. Because there were no treatments without any mulch, this 

growth enhancement is most likely due to increased soil water retention and reduced 

water stress on the trees. This is slightly contradictory to previous work (Arnold et al. 

2005; Gilman and Grabosky 2004; Greenly and Rakow 1995) where mulches of this 

depth reduced stem growth presumably due to reduced rainfall or irrigation water 

penetration to the root zone. The mulch used in the current work may have been more 

coarsely textured than mulches described in previous work and the larger mulch particle 

size could have played a role in allowing increased water infiltration through the mulch 

applications.  

 

Interestingly, final TCSA trends were inversed at the wound site (17.5cm), where 

smallest mean areas were observed in trees with 30 and 15cm of mulch with stem 

contact followed by trees growing with 15cm of mulch without stem contact. This trend 

may be more related to the amount of woundwood, or callus produced at the wound site 
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rather than overall growth potential, hence the differences observed in final wound area. 

 

Additionally, TCSA, when measured at 11cm off the ground, places the area of 

measurement below the mulch line in both 15 and 30cm mulch treatments with stem 

contact. There have been reports that covering tree stems with wraps can decrease the 

growth rate of juvenile, photosynthetic stem tissues and cause a decrease in stem caliper 

in affected areas (Mooter et al. 2004). It might be inferred that deep mulch may have a 

similar effect on buried stems but this is not supported by replicated research and did 

not appear to occur in this study. Similar work by Greenly and Rakow (1995) reports a 

decrease in shoot growth in white pine (Pinus strobus) and pin oak (Quercus palustris) 

under 15 and 25.5cm of mulch when compared to 7.5cm of mulch. If this is the case, 

the overall effect of enhanced stem growth under 30cm of mulch with stem contact may 

be due to improved soil moisture or other conditions that were enough to compensate 

for the loss of photosynthesis in covered stem tissue.  

 

Wound Occlusion 

There was no indication in this experiment that wounding had any significant effect on 

stem growth in any of the measured variables. Although final wound area and wound 

occlusion rate did not differ significantly between any of the mulch treatments, the 

significant increase in stem growth observed in 30cm mulch treatments with stem 

contact may have caused the slight increase in wound occlusion rate observed in this 

treatment. This rate of wound occlusion in 30cm mulch depths with stem contact has an 
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obvious temporal component because it did not cause the wounds to be closed more 

than other mulch treatments at the final observation.  

 

Greenly and Rakow (1995) also report that stem wounds on white pines (Pinus strobus) 

callused normally under 15 and 25cm deep mulch applications. Their work, however, 

did not quantify the rate or extent of occlusion. The 30cm deep mulch applications 

which covered the basal stem wound might also be compared to wound wraps or 

treatments studied by Hudler and Jensen-Tracy (2002), McDougall and Blanchette 

(1996), and Shigo and Wilson (1977); however, the lack of significant differences in 

wound closure or stem discoloration rule out speculation that 30cm of mulch in contact 

with the stem had an appreciable effect. 

 

Martin and Sydnor (1987) examined the correlation between growth rate and wound 

occlusion, especially to determine if there was significant interaction between growth 

rate and wound occlusion rate. Their results show that tree species is more often the 

cause of differences in wound occlusion rate and that growth rate of individual trees, 

within species, was poorly correlated to rate of wound occlusion. In contrast, Neely 

(1988a) states that tree vigor, specifically the rate of stem growth, directly affect the rate 

of wound occlusion, indicating that large stem wounds, resulting from branch pruning 

close to the main stem, closed more quickly than smaller wounds made when branches 

were cut at the branch collar. This is similar to the results from this study, which show a 

significant negative correlation between TCSA growth (measured at 17.5 cm) and the 
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extent of wound closure, indicating that wounds close more quickly as radial stem 

growth increases. O’Hara (2007) has suggested a similar relationship in occlusion of 

pruning wounds, stating that juvenile tree vigor enhances wound occlusion in forest 

stands and, furthermore, efforts should be made to make pruning cuts that close quickly 

thus reducing internal defects that may arise from delayed occlusion. 

 

Finally, the use of area measurements appears to be more accurate than linear 

measurements of wound width and/or height (Hudler and Jensen-Tracy 2002; Huggett 

et al. 2007) or calculation of wound area using an ellipse formula (Bai et al. 2005) in its 

ability to measure wounds of irregular or asymmetrical shape. The results from this 

study show an average overestimation of wound occlusion of up to 18% when 

comparing actual wound area (as measured using ImageJ) to that of the calculated area 

of an ellipse. Additionally, linear measurements alone may not be accurate enough to 

quantify wound occlusion.  

 

Stem Discoloration 

Due to the relatively young age of the trees used in this study (< 10 yrs.) it is unlikely 

they were undergoing processes that initiate heartwood formation.  

 

Most research has found that the amount of internal discoloration present at the time a 

tree is harvested is not related to the state of occlusion in existing wounds (Shigo et al. 

1977a; Vasiliauskas and Stenlid 1998). Vasiliauskas and Stenlid (1998) also report that 
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older wounds (10+ years) that were completely closed did not significantly reduce the 

amount of internal discoloration, either. Because wound occlusion and both measured 

parameters of internal discoloration did not differ significantly between any treatments 

in this study, it can be assumed that they are unrelated, at least at the time of harvest.  

 

Every stem that was sectioned longitudinally to examine columns of decay had darker 

and softer pith tissue at its center. This pith tissue can play a role in generation of 

discoloration and potential for decay during wounding. Additionally, if axial spread of 

discoloration reached the stem pith after wounding there may have been increased 

potential for longer vertical columns of decay, similar to results reported by Gilman and 

Grobosky (2006) where they observed more discoloration and decay in stems that had 

branches with connected pith to the main stem. 

 

The non-significant increase (20%) in length of discolored column under 30cm of 

mulch with stem contact may have been due to exposure to pathogenic fungi in the 

mulch covering the wounds. Similarly, Shortle et al. (1995) found that inoculation of 

wounds with pathogenic fungi (Pleurotus ostreatus and Trametes versicolor) caused 

more extensive internal discoloration. There may have been fungi and other 

microorganisms present in the mulch that invaded the wound after mulch application 

which caused this increase in discoloration in vertical columns.  

 

Other research has also explored the effects and interactions of growth rate on the extent 
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of internal discoloration and decay. In hybrid poplar, tree size and growth rate did not 

affect the ability of trees to compartmentalize (Shigo et al. 1977a). Several cottonwood 

clones were examined for internal columns of decay after artificial wounding (Shigo et 

al. 1977b). Tree diameter and wound occlusion did not have a significant effect on the 

extent of internal discoloration, hence the authors' suggestion that resistance to the 

formation of discoloration may be genetic and species-based rather than on physical 

characteristics of the wounded trees. Overall, stem growth rate, at least in this study, 

appears to be more of an indicator of overall tree health, rather than a predictor of 

wound occlusion or internal discoloration. 
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Tables. 

Table 1.  Mean final total cross-sectional stem area measured in cross-section at 11 and 17.5cm off the ground of Acer rubrum 

'Northwoods' as affected by a basal stem wound (wounded and non-wounded) and three different mulch depths placed against 

the tree stem (0, 15, 30 cm).   

  
Final Total Cross-Sectional Stem Area 

  
(mm

2
) 

    11cm Height 17.5cm Height   11cm Height 17.5cm Height 

Mulch Depth at Stem n Non-Wounded Trees Non-Wounded Trees n Wounded Trees Wounded Trees 

0 cm 7 3004.27 ± 724.10az 2670.49 ± 526.61a
z
 7 3670.31 ± 895.73a 3216.43 ± 512.39a 

15 cm 6 3796.74 ± 674.26a 3101.56 ± 460.35a 8 2888.72 ± 438.49a 3155.79 ± 643.77a 

30 cm 8 3880.79 ± 707.48b 2995.95 ± 450.81a 8 4033.19 ± 465.56b 2958.21 ± 495.76a 
z
Values within columns followed by different letters are significantly different using Tukey's HSD (P < 0.05). 

 

 

 

 

 

 

 

 

 

 



 

37 

 

Table 2.  Mean new growth and number of nodes measured in 2009 in Acer rubrum 'Northwoods' as affected by basal stem 

wounds and three different mulch depths against tree stems (0, 15, and 30cm). 

  
Non-Wounded Trees 

 
Wounded Trees 

  
New Growth Nodes 

 
New Growth Nodes 

Mulch Depth at Stem n (cm) (no.) n (cm) (no.) 

0 cm 64 21.7 ± 2.8az 7.1 ± 2.5a 56 21.2 ± 3.1a 6.9 ± 2.4a 

15 cm 64 20.7 ± 1.7a 7.0 ± 2.0a 63 22.9 ± 1.9a 7.5 ± 2.1a 

30 cm 64 27.2 ± 1.7a 8.5 ± 2.2b 63 21.4 ± 2.3a 7.6 ± 2.1a 
z
Values within columns followed by different letters are significantly different using Tukey's HSD (P < 0.05). Branches were collected 

between a height of 1.0 and 1.5 m, two in each of the cardinal directions. 
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Table 3.  Mean final wound closure (% of total area occluded) of Acer rubrum 'Northwoods' as affected by a basal stem 

wound and three different mulch depths placed against the stem (0, 15, 30 cm). 

 
 

Wound Occlusion 

Mulch Depth at Stem n (%) 

0 cm 7 98.24a
z
 

15 cm 8 98.52a 

30 cm 8 97.19a 
z
Values within rows followed by different letters are significantly different using Tukey's HSD (P < 0.05). 
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Table 4. Mean percent area and percent length of stem discoloration observed in cross-sections (horizontal cuts) and bi-

sections (vertical cuts) of Acer rubrum 'Northwoods' as affected by a basal stem wound and three different mulch 

depths placed against the tree stem (0, 15, 30 cm). 

  
Discolored Stem Area in Cross-Section 

 
Discolored Stem Area in Bi-Section 

 
 

(%) 

 

(%) 

Mulch Depth at Stem n   n   

0 cm 7 14.24a
z
 7 63.06a 

15 cm 8 11.41a 7 63.13a 

30 cm 8 9.74a 7 82.86a 
z
Values within rows followed by different letters are significantly different using Tukey's HSD (P < 0.05). 
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Figure 1.  Making basal wounds with a grafting knife in Northwoods red maple (Acer 

rubrum ‘Northwoods’). Initial wound dimensions were 25.4 mm (horizontal) x 50.9 mm 

(vertical). 
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Figure 2.  Finished basal wounds in Northwoods red maple (Acer rubrum 

‘Northwoods’) showing removal of a 25.4 mm (horizontal) x 50.9 mm (vertical) section 

of bark and active vascular cambium. 
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Figure 3.  Diagram of harvest protocol used to section Northwoods red maple (Acer 

rubrum ‘Northwoods’ ) for investigations into internal discoloration. 
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Figure 4.  Example wound occlusion in Northwoods red maple (Acer rubrum 

‘Northwoods’ ) after 30 months. Photos taken on 22 June 2007 (left), 08 August 2008 

(middle), and 26 August 2009 (right). Photos represent a tree with a mulch treatment 

that was not in contact with the stem.  
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Figure 5.  Cross section example of a wounded Northwoods red maple (Acer rubrum 

‘Northwoods’) showing extent of discoloration in the horizontal plane at 17.5cm (top) 

and formation of callus tissue in response to basal stem wounding and section used for 

area measurements at 11cm (bottom). 
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Figure 6.  Area of cross-sectional discoloration in Northwoods red maple (Acer rubrum 

‘Northwoods’) as calculated by ImageJ through automatic delineation. 
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Figure 7.  Cross-section example of a non-wounded Northwoods red maple (Acer 

rubrum ‘Northwoods’), provided as comparison to Fig. 5. Cross-section at 17.5cm 

(top) and 11cm (bottom). 
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Figure 8. Bi-section example of wounded Northwoods red maple (Acer rubrum 

‘Northwoods’) cut longitudinally to expose column of discoloration resulting from 

basal stem wounding. 
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Figure 9.  Bi-section of non-wounded Northwoods red maple (Acer rubrum 

‘Northwoods’) cut longitudinally provided as comparison to Fig. 8 and to 

demonstrate presence of darkly-colored pith present in all sampled trees. 
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Appendices 

Appendix A: Harvest and Sectioning Protocol 

 

1. Mark ROW & POS and NORTH (N) on tree stem with Sharpie 

2. Make Cut 1 at ground level with hand saw and bring intact tree to greenhouse 

3. Measure and record total height in cm 

4. Collect eight random branches and measure and record the length of new 

growth. Two branches should be from each cardinal direction (North, South, 

West, and East). Collect between waist and eye level. (Branches could be stored 

for later measurement).  Tag branches with ROW & POS.  

5. Cut stem just below first branch with hand saw 

6. Remove and store rest of crown for future dry weight measurement 

7. Measure distance from Cut 1 to blue tape (mulch depth) 

8. Take a photograph of wound (if wounded treatment) with scale reference 

(include ROW & POS in photo) 

9. Find the center of the original wound and measure 6.5 cm below  – mark this 

point  

10. Make Cut 2 on the band saw at the point determined in step 9 

11. Make Cut 3 on band saw directly through the center of wound, making a cross-

section of the wound 

12. Sand both faces of section cut in steps 10 & 11 on belt/disc sander 

13. Store section in sealed plastic bag with ROW & POS labels and SECTION C/D 

14. Measure points along the remaining stem section in order to cut the stem straight 

down the vertical axis (i.e. bisecting the stem vertically) 

15. Make Cut 4 along the points made in step 14 

16. With the wound facing you  mark the right section B and the left section A 

17. Immediately place SECTION A in a garbage bag for freezer storage (decay 

detection analysis) 
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18. Sand areas of interest on SECTION B for photography (discoloration, 

wounding, etc.) 

19. Bring SECTIONS B, C, and D to lab for photography 

 

Appendix B: General ImageJ Protocol 

Objective: The quantification of total area and/or automatically measuring the amount 

of discoloration in a section of wood.  

 

Preparing the Image: 

1. Open the image to be analyzed [File → Open or Ctrl+O]. 

2. Resave the JPEG image as a lossless TIFF [File → Save As Tiff…] in the 

appropriate folder using the conventional naming system. 

3. Set the scale [Analyze → Set Scale…] in millimeters using the straight line 

selection (in the task bar) of known length.  

.  

 

Preliminary Image Processing: 



 

57 

 

To perform a semi-automatic delineation of the total and discolored areas of the stem, 

the image must be in converted into grayscale and thresholds will be used. 

1. Convert the image into grayscale [Image → Type → 8-bit]. 

 

2. Save the image as a Tiff again [Save As → Tiff…] in the folder labeled 

“Grayscale”. If at any time during the rest of the process you want to start over, 

using the revert function [File   Revert or Ctrl+R] will return you to this phase. 

3. Invert the image. [Edit → Invert or Ctrl + Shift+I] 
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Which results in this: 

 

4. Open up the “Threshold” function [Image →Adjust → Threshold or 

Ctrl+Shift+T] 

 

At this stage it is probably a good idea to have the original image open nearby, for the 

sake of comparison. 

 

The next step involves automatically drawing a boundary between the stem area and the 

background. The image has been inverted from the grayscale so that the background is 

white (or lighter gray in this case). The “Threshold” option creates a binary image 

where pixels with gray values above the threshold are assigned a different value than 

those below. 
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In the “Threshold” box a histogram is displayed. As the active image is in (inverted) 8-

bit grayscale, every pixel on the screen has a value between 1 (the blackest black) to 

256 (the whitest white). The histogram displays the distribution of these values within 

the image. Using the scrolling bars (or the “Set” button) which pixels will be included 

can be determined and set.  

 

 

5. After the appropriate threshold is determined, press the “Apply” button and the 

image will be converted to a binary, like so: 
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The reason image was inverted was so that the non-discolored wood would be the 

darker pixels and would then be the area(s) being selected during the thresholding 

process.  

 

6. Select the “Magic Wand” in the toolbar. 

 

And select a point to the left of the segmented binary image area of interest: 

. 
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At this point, the “Magic Wand” will move from left-to-right, and when it ‘hits’ the 

binary object, will magically trace it around the continuous outline. In this example that 

would be the non-discolored wood, which while inverted is darker.  

 

 

 

Pressing “Add” (or “t’) in the ROI Manager will automatically make this an area of 

interest which can be renamed, saved, measured, etc.   

 

Troubleshooting: Manual Delineation 

With the area of interest for the non-discolored section highlighted, revert the image 

back to the original saved grayscale form. 

 

Contrast the area of interest generated by binary thresholding to visual perception. In 

this case, the top non-discolored section has been automatically delineated perfectly. 

However, the bottom with that same threshold is not. This could be due to variation in 

the amount of discoloration present within the discolored stem section. 

 

To remedy this: 

1. Adjust the threshold until the areas of interest are delineated. 
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or 

2. Make a note of the area(s) where the “Magic Wand” is deviating from its desired 

path, and manipulate the area to put it on its correct path. 

 

In this case, the center third of the top half of the lower non-discolored section, the 

lower left corner, and a few spots on the bottom are the problem. 

 

Using the ‘Color Picker’ tool in the toolbar [Image → Color → Color Picker]; select a 

color to trace around the aforementioned areas of contention, by placing the cursor on 

that color and clicking. The ‘x’ and ‘y’ fields are the ‘coordinates’ of where the cursor 

is on the image screen. The ‘value’ field is the color value of the selected pixel, which 

will range from 0-256 with grayscale.    

 

 

The current color of selection will then appear in the ‘Color Picker’ box (as is seen 

below). Switch to the ‘Drawing Tools’ on the alternate macro tool sets list.  

 

The toolbar will then appear as: 
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Displayed are now standard drawing tools (similar to Microsoft Paint). The drawing 

properties of any tool can be changed by double clicking on the icon. In this case, use 

the ‘Pencil’ tool. Its default is set to 1 pixel wide, change it to 4. 

 

The light gray from the (inverted) background is chosen to delineate between the 

discolored and non-discolored stem sections.  

1. Use the pencil tool to draw a line along between the two where there were 

problems with thresholding. It is useful to keep up a copy of the thresholded 

image alongside the active image as well as zooming in. 



 

64 

 

 

In the areas where the non-discolored section was indistinguishable from the 

background, select a darker color and pencil in delineation. 

- 

2. Reset the threshold: 
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3. Reapply to make the binary: 

 

4. Use the ‘Magic Wand’ to highlight the new delineation, add it to the ROI 

manager [“t” or ‘Add’ on the manager itself] 

 

Revert the image back to its original grayscale and compare. 

 

Click the ‘Show All’ button on the ROI Manager to see both, and finish up with the 

image. 
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Appendix C: Section B ImageJ Protocol 

Objective: The quantification of total length or column of discolored wood in bisected 

tree stems using ImageJ.  

 

Preparing the Image: 

1. Large tent with 4 side lights one large light at opening 

a. Distance from left side 

b. Distance from right side 

c. Distance from opening 

2. Camera settings 

a. Shooting Mode = Auto 

b. Shutter Speed = 1/125 

c. Exposure Compensation  = 1.0EV 

d. Auto Focus = Frame Selection 

3. Open image in ImageJ and rotate to make vertical (Image  Transform  

Rotate (about -28 deg) 

4. Analyze  Set Scale and click “Click to Remove Scale” 
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5. Resave the Jpeg image as a lossless Tiff [File → Save As Tiff…] in the 

appropriate folder using the conventional naming system. 

6. Set the Scale [Analyze → Set Scale…] in millimeters using the straight line 

selection (in the task bar) of known length (10 mm) and select Global. 

7. Crop image as necessary to eliminate outside features 

a. Bisect reference arrow precisely 

b. Edit  Clear Outside 

8. Save in Cropped TIFF folder 

9. Convert to 8-Bit grayscale 

10. Open uncropped TIFF for reference in right screen 

11. Measure total length of section using the straight line selection (in the task bar) 

[Analyze Measure] 

12. Measure total length of discolored portion of section using the straight line 

selection (in the task bar) [Analyze Measure] 

13. Copy or enter data into spreadsheet under “Discolored Stem Length” in mm 

 

 

Appendix D: Section C - ImageJ Protocol 

Objective: The quantification of total amount of discolored wood in cross-sectioned tree 

stems using ImageJ.  

 

Preparing the Image: 

1. Open the image in MS Paint, select area of interest (Free-Form Select (Star) tool 

and re-save in “Cropped” Folder with same filename. 

2. Open in ImageJ uncropped file to be worked with [File → Open or Ctrl+O]. 

3. Analyze  Set Scale and click “Click to Remove Scale” 

4. Resave the Jpeg image as a lossless Tiff [File → Save As Tiff…] in the 

appropriate folder using the conventional naming system. 
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5. Set the Scale [Analyze → Set Scale…] in millimeters using the straight line 

selection (in the task bar) of known length (10 mm) and select Global. 

6. Measure total stem area using freehand select.  Save value in “Total Stem Area” 

spreadsheet in mm
2
.  

7. Measure stem diameter in two directions (N-S and E-W) and save values in 

spreadsheet in mm. 

8. Move uncropped photo aside for reference. 

9. Open cropped image and save as TIFF in Cropped folder 

10. In ImageJ set measurements [Analyze Set Measurements, click ‘Limit to 

threshold’]  

11. Convert to binary image [Process BinaryMake Binary] 

12.  Save Binary Image as TIFF with same filename in Binary TIFF folder. 

13.  Measure Area [Analyze Measure] 

14. Copy or enter data into spreadsheet under “Discolored Stem Area” in mm
2
 

 

Appendix E: Section D - ImageJ Protocol 

Objective: The quantification of total stem area and diameter in two directions using 

Image J. 

 

Preparing the Image: 

1. Open ImageJ 

2. Analyze  Set Measurements check only “Area” and uncheck everything else 

3. Open in ImageJ uncropped file to be worked with from the Mulch Study C&D 

Photos folder [File → Open or Ctrl+O] 

4. Zoom in and draw a 10mm line using the straight line tool on the ruler. 

5. Set the Scale [Analyze → Set Scale…] put “10” in the known distance box and 

“mm” in the unit of length box and check “Global” 
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6. Resave the JPEG image as a lossless TIFF [File → Save As Tiff…] in the 

“Section D” folder “Uncropped TIFFS” subfolder  using the “ROW-POS” D 

naming system 

7. Crop outside of bark, removing all pins, scale, and visible stem below the plane 

of focus 

8. Save image in “Section D” folder “Cropped TIFFS with Scale” subfolder. 

9. Measure stem width (NS) and (EW) using the line tool including the bark 

and bisecting the first year’s growth. Use CTRL-M or Anaylze  Measure 

Function and record the data into the spreadsheet in the appropriate column 

10. Convert to 8-Bit grayscale (Image  Type  8-Bit) 

11.  Image  Adjust  Threshold select “B&W” from dropdown menu.  Adjust 

slider bars to highlight outer edge of bark 

12. Save image in “Cropped Binary TIFFS with Scale” folder 

13.  Select a point on outer edge using the magic wand tool.  Check highlighted area 

with original photo to ensure accurate tracing 

14.  Measure area of selection (CTRL-M) and record the data in the spreadsheet in 

the appropriate column 

15. Clear area inside bark (Edit  Clear) 

16. Save generated outline in “Outline with Bark” folder as TIFF. 

17. Click Edit  Undo 

18. Re-adjust threshold levels to enhance and clarify the inner edge of bark 

19.  and crop everything inside that area using tool of choice and EditClear or 

“Backspace” functions 

20. Select a point on inner edge of bark using the magic wand tool.  Check 

highlighted area with original photo to ensure accurate tracing 

21. Measure selected area (CTRL-M) and record the data in the spreadsheet in the 

appropriate column 

22. Edit  Clear Outside 
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23. Edit  Clear 

24. Save outiline in “Outline without Bark” as TIFF 

 

Appendix F: Wound Occlusion - ImageJ Protocol 

Objective: The quantification of total stem area and diameter in two directions using 

Image J. 

 

Preparing the Image: 

1. Open the image to be worked with [File → Open or Ctrl+O] 

2. Resave the Jpeg image as a lossless Tiff [File → Save As Tiff…] in the 

appropriate folder using the conventional naming system 

3. Set the Scale [Analyze → Set Scale…] in millimeters using the straight line 

selection (in the task bar) of known length 

Measurement: 

1. Trace the wound using freehand tool 

2. Analyze using [Analyze →Measure] 

3. Paste measurement into Excel sheet 

4. Measure height and width through center of wound using line tool and analyze 

using [Analyze →Measure] 

5. Paste measurements into Excel sheet 

 

 


